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1. Introduction

Purpose

This document outlines the process of configuring the software integration between Nedap’s
AEOS and Invixium’s IXM WEB.

Description

IXM Link, a licensed module in IXM WEB, is required to synchronize the user database between
IXM WEB (where biometric enrollment for users is performed) and Nedap AEOS Software
(where access rules for the users and the organization are managed).

Note: To activate IXM Link within IXM WEB, the installer must contact Invixium Support
at support@invixium.com to obtain the activation key.

The following sections will describe how to set up and configure IXM Link to keep IXM WEB
users in sync with AEOS by using “Web Service” to import and export cardholders.

Acronyms
Acronym Description
IXM Invixium
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Field Mappings
The following are the Nedap AEOS fields that are mapped to IXM WEB

Nedap AEOS Field IXM WEB Field Notes

First name First Name

Last name Last Name

Identifier This is mandatory for adding users to

Number (Card) Nedap AEOS from IXM WEB.

(Identification)
Identifier Type

(Identification) Card Type (Card)

Cards with the status “In Use” and

Status Replacement” in Nedap AEOS are only

\dentificati Status (Card) synchronized to IXM WEB as “Active
(Identification) Card’. In the case of other statuses, card

status will sync as “Inactive” in IXM WEB.
Photo Photo

@ Note: Multiple Cards — Nedap AEOS can have multiple identifiers (cards) per person, and
IXM WEB supports a maximum of 10 cards per employee.
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2.Compatibility

Invixium Readers
TITAN TFACE TOUCH2 SENSE?2 MERGE2 MYCRO

All models All models All models All models All models All models

Software Requirements

Application Version

Nedap AEOS 2021.1

Invixium IXM WEB 2.3.0.0

Operating Systems Windows Server 2008 R2 SP1

Windows Server 2012

Windows Server 2012 R2
Windows 10 Professional Version
Windows Server 2016 Standard
Windows Server 2019

Microsoft .NET Framework .NET Framework 4.8

Database Engine SQL Server 2014 or higher

Internet Information Services  Microsoft® Internet Information Services
(1S) version 7.5 or higher

Web Browser Google Chrome

Mozilla Firefox

Microsoft Edge (Internet Explorer not
recommended)
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Other Requirements

Server 2.4 GHz Intel Pentium or higher
RAM 8 GB or higher
Networking 10/100Mbps Ethernet connections

@ Note: Server requirements mentioned are ideal for small to medium business installations.

For large enterprise installation server requirements, contact support@invixium.com.

Compatibility Matrix for IXM WEB & Nedap AEQOS Integration:

IXM WEB version Nedap AEOS version Compatible
IXM WEB 2.2.224.0 2021.1 Yes
IXM WEB 2.2.230.0 2021.1 Yes
IXM WEB 2.2.252.0 2021.1 Yes
IXM WEB 2.2.330.0 2021.1 Yes
IXM WEB 2.3.0.0 2021.1 Yes

Table 1: Compatibility Matrix for IXM WEB & Nedap AEOS

13
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3. Checklist
Iltem List Interface
Prerequisites for IXM WEB Installation Invixium
Installation of IXM WEB Invixium
Email Configuration in IXM WEB Invixium
IXM WEB and IXM Link Activation Invixium
Configure IXM Link for Nedap AEOS Invixium
Creation of System Users in IXM WEB for .
Enroliment Invixium
Configure Invixium Readers Invixium
Add an Invixium Device to a Device Group Invixium
Face, Fingerprint or Finger Vein Enroliment Nedap AEOS
ilrze(r)esquisites for Getting Access in Nedap Nedap AEOS
OSDP Configuration Invixium & Nedap AEOS
DIP Configuration Invixium & Nedap AEOS
Wiegand Configuration Invixium & Nedap AEOS
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4. Task List Summary

Task

IXM WEB Application Task List

Nedap AEOS Task List

Activate IXM WEB and IXM Link
for Nedap AEOS

Enroll biometrics (face, fingerprint,
finger vein) from Nedap AEOS

Configure IXM Link for Nedap
AEOS

Mandatory configurations for getting
access in Nedap AEOS

Add new System Users in IXM
WEB for enrollment

OSDP / DIP / Wiegand Configurations
in AEOS and AEmon

Register IXM Devices and
configure settings as per the
requirement

Configure OSDP settings on the
device for integration with the
Access Panel

Configure DIP settings on the
device for integration with the
Access Panel

Configure Wiegand settings on
the device for integration with the
Access Panel

Table 2: Task List Summary
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5. Prerequisites for Installing Invixium IXM WEB Software

Getting IXM WEB activation key
Procedure

Complete the online form to receive instructions on how to download IXM WEB:
https://www.invixium.com/download-ixm-web/

IXM WEB Download and Activation

Fill out the details below to receive an email with steps to download, install and activate IXM WEB

Who are you?

@ Distributor
Access Control Panel Manufacturer
Installer/Integrator

End User

Customer Details
Please provide details of the End-User who has purchased Invixium biometric solutions and where they will be installed. The Activation License for IXM WEB will be
issued in their name and will provide them access to future upgrades and support

First Name* Last Name* Company Email*

Company Name* Select Country* v Phone Number*

Installer Details
Please provide details of the person and/or company responsible for installing IXM WEB at the aforementioned customer’s facility. The license key will be emailed to the
customer email ID as well as the email ID provided below.

First Name* Last Name* Company Email*
Company Name* Phone Number*

Street Address 1 Street Address 2 City*

State* Select Country* v Postal Code*

Figure 1: IXM WEB Online Request Form

After submitting the completed form, an email will be sent with instructions from
support@invixium.com to the email ID specified in the form.

Please ensure to check the spam or junk folder.
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See below for a sampleemail that includes instructions on how to download and install IXM
WEB along with your Activation ID.

Get the Iatest XM WEB package from the link below. Depending on your infemet speed, the download will take approximately 15 minutes.

Impartant:

1. Do not updale if you are using [XM SDKs, a custem firmware or a custom LXM YWEE version. Contact XM Suppart for more details.

2 After updaling IXM WEE. make sure all devices are first updated to the latest firmware before enralment. configuration or changing seftings

3. For existing TITAN or TFACE users, this update of XM WEB requirss temporary intsmet connactivity o acesss Invixium servers for license validation. If connacting o the intermet is not passible at your premises. contact IXM Support for help

4. For new customers, Microsoft SGL version 2014 vill be installed along with XM WEE 2.2. For existing customers, plsase upgrade fo Microsoft SGL 2014 or higher before upgrading X1 WEB.

XM WEB 2.3.0.0 package

activation 10 1vv-04-G6- [N

Follow these steps to install o update IXM WEB:

1. Download the IXM WEB package
2. Exdract the compressed files and copy IXM WEB.exe fo required server.
3. Install IXM WEB, open and create a login

New IXM WEB installations require Activation. To activate XM WEB, first open and create a login and then follow these steps:
1. Qnline Activation (Recommended) - Requires an active infernet cannection.
= Goto Left Havigation Menu — LICENSE — IXM WEB
o Select “Online” as activation Type. Enter your Activalion 1D and Click "activate”.
o Your Activation ID will be validated automatically and LXIM WEB will be ready for use.
2. Offline Activation - For servers that are offline.
= Goto Left Navigation Menu — LICENSE — IXhl WEB
= Select “Offline” as Activation Type. Enter your Activation ID and Click “request”.
= Copy the details that pop up and email them to support@invixium.com.
= Our support team will send you an email with an Activation Key to activate IXM WEE
= Once you receive the Activation Key, select the “Offine” as Activation Type and enter the Activation Key. Glick Activate {o start using LXM WEE.

Enjoy the Experience!

Figure 2: Sample Email After Submitting Online Request Form
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Minor Checklist and Considerations

Use these tables to verify that you have conducted all required steps.

Other Minor Checklist

Windows Operating system needs to be up to date.

Windows Updates System updates should not be pending. If any update is
downloaded, you will have to restart the system to complete the
Windows update.

The person who is setting up IXM WEBshould have full

User Privileges administrator rights

Table 3: System Related Checklist

Port Assignment Port
Inbound HTTP Port 9108
TCP 1433
Port to communicate 9734
between IXM WEB &

Devices

Inbound Port 1255
Nedap AEOS Port 8444

Table 4: Port Information
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6. Installing IXM WEB

Software Install

Procedure
STEP 1

Run the IXM WEB installer (Run as administrator). Click Install to continue. It will display
apopup window to accept the License Agreement.

¥ IXM WEB X

y

Advanced News

Figure 3: IXM WEB Installer

19 P/N XAD-TPI-004-03G



v

INVIXIUM

STEP 2

Click ‘“Yes’ in the popup window. The IXM WEB installer will start a basic installation process.
STEP 3

By default, IXM WEB performs basic installation and installs software to the default location with
the default port number. If the user wants to, they can change the installation path and specify a
port number that communicateswith the IS server. Click Advance.

¥ IXM WEB X

/

Advanced Options

C:\Program Files (x86) \ Invixium m

9108

[ Install SQL Server W

) . Install
V] Install Certificates

Figure 4: Advanced Option in IXM WEB Installer

STEP 4

In Advanced installations, the user can change the following options:

¢ Installation Path: In basic installation, the default path is — “C:\Program Files
(x86)\Invixium”. By changing the path, users can determine the new physical path
on the machine where the IXM WEB package will be extracted.
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e Port Number: By default, the port number is “9108”. Users can change the port
number that is generally used to communicate between the WEB Server (Internet
Information Services) and IXM WEB.

¢ Install SQL Server: By default, this field is always selected. It means that IXM WEB
will install SQL Server 2014 Express Edition along with the IXM WEB application.
Users can uncheck this field if any other version of SQL Server will be used or if a
different machine will be used as a database server.

¢ Install Certificates: By default, the IXM WEB installer installs all the necessary
certificates that are used in SSL communication.If IXM WEB is configured over the
cloud, it will install a specific certificate for that purpose. Users can uncheck this field
to prevent IXM WEB from installing all the necessary certificates. Invixium does not
recommend deselecting this field.
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STEP 5

Once the user completes the changes, click Install. IXM WEB packages will continue to install
on the machine, and it will display the progress when any component is installed in the
background.

Installation In Progress
——

Figure 5: IXM WEB Installation
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STEP 6

Once the installation process completes, the user will need to click Complete to finish.

(= =0
Py \ —t
7 O
havad L
Complete License
¢ I==I
Advanced News

Figure 6: IXM WEB Installation Completed

STEP 7

The IXM WEB package will create a shortcut icon on the desktop after the process.

Y

@4
IXM WEB

Figure 7: IXM WEB Icon - Desktop Shortcut
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STEP 8

Double click on the shortcut icon from the desktop to open IXM WEB in the default browser.
Users can also open a browser and run the IXM WEB application.

Configuring IXM WEB Database

Authentication SQL Server Name

‘ Windows v ‘ ‘ IXM-LT-03\IXMWEB

Figure 8: IXM WEB Database Configuration

STEP 9

IXM WEB will populate the default SQL Server Name and SQL Server Instance.
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STEP 10

If the user wants to configure the database that is installed on another machine, then select the
‘SQL Server’ option from the Authentication field. By selecting the ‘SQL Server’ option, the
user will be required to add credentials (SQL Username and Password) to connect to the
database server machine.

Configuring IXM WEB Database

SQL Server v IXM-LT-03\5QL2019 v

‘ cuclmin‘ LIXTTTT LYY

Figure 9: SQL Database Configuration

STEP 11

If a user wants to use the same database instance of the same machine, then click connect to
verify if the connection is established with the SQL Instance.
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STEP 12

Enter a new Database name if there is no previously set up database available.

Configuring IXM WEB Database

Authentication SQL Server Name

‘ Windows IXM-1T-03\5QL 2019

Database Name

‘ IXMDB

e Dk

Figure 10: IXM WEB Database Name
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STEP 13
Click Next.

Configuring IXM WEB Database
Authentication SQL Server Name

Windows v | IXM-LT-03\5QL2019

Database Name

IXMDB

CREATE ACCOUNT
INVIXIUM ID Password Very Weak

Confirm Possword

Server URL Cloud Port

http//localhost:9108 1255

Figure 11: IXM WEB Administrator User Configuration

STEP 14

Users can provide the necessary values to all the fields displayed under the ‘Create Account’
section.

STEP 15

The fields and their functions are mentioned below:

e Invixium ID: Users can add a username that will have all the rights to access any settings
within IXM WEB. This Invixium ID should have a minimum of 5 characters. This Invixium
ID configuration will have Administrator rights.

e Password: The user can set a password. While typing the password, IXM WEB will also
display the strength of the entered value to determine how secure the password field is.
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Confirm Password: Enter the password value once again. Users need to enter the same
password that is entered in the password field.

Email: Set an administrator email address. IXM WEB will use this email address in the
future in case the password needs to be reset, or any email notification must be sent.

Server URL: Users can set a Web URL or an IP Address on the machine where IXM WEB
is installed along with the port number. By default, the port number is 9108. Format:
http://IP_IXMServer:9108

Cloud Port: If a user wants to configure the devices over WEB Cloud, then a specific port
number needs to be mentioned in the Cloud Port field. By default, the Cloud Port value is
1255.
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STEP 16

Once the user is done with providing all the values, click Save.

Configuring IXM WEB Database
Authontication SQL Sorver Namo

windows DOM-LT-03\SQL2019

Password recur GEEELLD

admin sessscnene

Confirm Password Email
ssssscnvene support@invixiumcom

Sorvor URL Cloud Port

http/1921680129108 ] 1256
- =

Figure 12: Save Database Configuration

P/N XAD-TPI-004-03G



INVIXIUM

STEP 17

Using the provided values, IXM WEB will create a database and upon success, the user will be
redirected to the Login Page.

X

Login

Enter details below

M Enter INVIXIUM ID

@ Enter Password

] keep me Signed In

Configure Email ‘ English v

You are currently using a 30-Day TRIAL version. To Activate IXM WEB, go to
LICENSE -> Activate IXM WEB.

Figure 13: IXM WEB Login Page
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7. Configuring Email Settings Using IXM WEB

Configuring email settings is highly recommended as one of the first steps after installing IXM
WEB. Email configuration settings will help the admin retrieve the password for IXM WEB in
case it is forgotten. Valid email configuration makes activation and license key requests easier.

Email Setting Configuration

Procedure
STEP 1

Click Configure Email on the Login page.
OR

Expand the Left Navigation Pane - Navigate to Notification Settings - Email
Configuration - Click Manage Preferences.

X

Login
Enter details below

A& Enter INVIXIUM ID

a Enter Password

E] Keep me Signed In

| Configure Email I ‘ English v

Figure 14: Configure Email
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STEP 2

Select ‘Enable Email Configuration’ and enter values for ‘SMTP Host,” ‘SMTP Port’ and
‘Send email message from’ fields.

f# Email Configuration

Enabilc Email Configuration

587

Figure 15: IXM WEB - SMTP Settings

@ Note: If Gmail/Yahoo/MSN etc. email servers are used for “SMTP Host” then “SMTP Login” and
“SMTP Password” values need to be provided. Also in this case, “Secure Connection” needs to
be set to either SSL or SSL/StartTLS.
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STEP 3

After entering the values, click Save to save the SMTP Settings on the IXM WEB Database.

o Email Configuration

Email settings saved

Figure 16: IXM WEB - Save Email Settings

To test the settings, Navigate to Notification Settings from the Left navigation Pane - Go to
Email Configuration - Click the Test Connection button on the right.

Email Configuration Email Alerts Push Notification Fire Zones Device Down Notification

SMTP Settings & Manage Preferences % Test Connection

Enable Email Configuration SMTP Host SMTP Port Send email messages from Secure Connection SMTP Login SMTP Pasaword
Enabled smtp.office3ébecom 587 hvadavio@invixium.com StartTLs hvadavia@invixium.com sEsaEEs

Figure 17: IXM WEB - Test Connection
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Provide a valid email address. Click Send to send a test email.

% Email Configuration

Send test email to

Figure 18: IXM WEB - Enter Email ID
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STEP 4

Once email configuration is completed, a Forgot password link will appear on the Sign In page
in its place.

V4

Login
Enter details below

‘ %4 Enter INVIXIUM ID

‘ @ Enter Password

[] keep me Signed In

Forgot Password ? English  ~

Figure 19: IXM WEB - Forgot Password
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8. Software and Module Activation

IXM WEB Activation
Procedure
STEP 1

Log into IXM WEB.

X

Login

Enter details below

N Entor INVIXIUM ID

@ Enter Password

Configuro Email English v

You oro currently Lsing © 30-Doy T vorson 10 Activate 0OV WILEL go to
LICENSE -> ACtivoto 104 WEB

Figure 20: IXM WEB - Enter Login Credentials
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STEP 2

Select the License Tab and then select the IXM WEB module to request an activation key for
IXM WEB.

o] Y IXM WEB

Invixium Access pvt itd ICENSED MODULES

Home (

N P N7) — e A
o L N4 N/ ° A X cQ0
& J / 7 4 ) f 5
5, Video Surveillance ~ " < b
XM WEB Conver! t CREDENCE ID Data Adapter XM AP XM Health IXM Mobile XM Time Trans! late Visitors
Organization Hierarchy
XM MOBILE FEATURES
Logs
A Notification Settings E ol @
Link ( G al o~
Dighal Card  Dynamie QR Card Foce Envoliment
= License
5 XM LINK INTEGRATIONS
Sync
General Settings
Schpeider @ reneionios nedap Oragovsori | Dowmmerom SIEMENS  Feenics  Whaxton  OLENELS2  GLENELS2
Company Schedule
oo e Accoss tt Agos Command Centro  Control Contor  DNA Fusion Fusion xoop Notz NotBox oncuard
£ Tools
Honeywell Genelec SIEMENS SIEMENS 5 GALAXY Honeywell
Report
. Pro-Wotch  Socurity Contor SiPass siort Systom Galaxy Win-Pok
System

Figure 21: IXM WEB - License Setup

STEP 3

Request Activation Key Online or via Offline Activation Options.

@ Note: The Activation ID is in the email you received when registering. If online activation fails,
check with your local IT department as the client may be blocked by your network.
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STEP 4

Once the system is activated, the Status will be displayed as Active.

N
&

IXM Web

Your current version of IXM Web is Active

Activation Date: 30/11/2022 Expiration Date: 30/12/2023

Activation Type

‘ Online

Activation ID

‘ Enter Key

v Activate

Need Help? Contact customer support

Figure 22: IXM WEB - Online Activation
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Nedap AEOS Module Activation

The option to activate a Nedap AEOS License is available under the License tab.

STEP 1

Request a License.

STEP 2

From Home, expand the Left Navigation Pane, and go to the License tab. Click on Nedap

IXM WEB

LICENSED MODULES

18 B @ @ @ @ ¥ B » &

IXM WEB Convert CREDENCEID Data Adapter IXM API IXM Health IXM Mobile IXM Time Translate Visitors

IXM MOBILE FEATURES

4 g [37 7 eﬂ
3 E e, U~2J

Digital Card Dynamic QR CardFace Enroliment

NTEGRATIONS

Schneider  @ronotogios | nedap © ndigovisen O ooennrns SIEMENS Feenics WPaxton @ LENEL:S2
)
Access Expert  Access It! AEOS ommand Centre Control Center  DNA Fusion Fusion Keep Net2 NetBox
G LENEL:S2 Honeywell Genetec SIEMENS SIEMENS K GALAXY Honeywell

5]

Figure 23: IXM WEB - Nedap Link Activation
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STEP 3

You will receive an email from Invixium Support having a license key for the Nedap
AEQOS Activation.

From: Invixium Technical Services [support@invixium.com]
Sent: 14/1/2022 9:27 pm

Subject: IXM Link Activation For Nedap Integration

Dear [N

Thank you for purchasing IXM Link. Your license details are given below:
Access Control Panel: NEDAP

Number of devices: 200
License Key:

To activate your IXM Link license, follow these steps:

Open XM WEB and login

Expand Left Navigation Panel

Click License tab

Select the required Access Control Panel manufacturer
Enter the License Key given above and click Activate

IXM Link should be activated and ready to use.
Enjoy the Experience!

For any queries, contact Invixium Technical Services Team.

Best Regards,

Invixium Technical Services Team

Contact US: +1 844 INVIXIUM (468 4948) Email: support@invixium.com
‘Work Hours: 12:00AM to 5:00PM (Eastern Time) Skype: invixium_support

This email and any attachments may contain confidential and privileged information. If you have received this message in error, please notify us immediately and destroy the material in its
entirety, whether electronic or hard copy. Also, please consider the environment before printing this email_

Figure 24: Nedap AEOS License Key Email
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STEP 4

Copy and paste the License Key in the box provided, and then select Activate.

Jrnedap

AEOS

Integrate Employees between IXM WEB and AEOS by nedap for easy
management of users.

‘ Enter Key

v Activate

Need Help? Contact customer support

Figure 25 IXM WEB - Activate Nedap AEOS Link License

RESULT

IXM WEB is now licensed for use with Nedap AEOS and configuration can begin.
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9. Configuring IXM Link for Nedap AEOS

Procedure
STEP 1

From the Left Navigation Pane - Link - click the AEOS (Nedap) icon.

Y IXM WEB

Invixium Inc. .\ AEOS

Toronto Nedap

Keep

B>

Home

System Galaxy
Video Surveillance

Command Centre

g

Organization Hierarchy

Security Center

Logs

ALkl

Notification Settings ?’0’ Watch

lod It

Link V b NetBox

License : OnGuard

Eh)

Figure 26: IXM WEB - Link Menu
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STEP 2

Toggle the Status switch to enable.

% Nedap
nedap - E
rvico URL Wob Service Usor Wob Service Password Interval (soc
hitps://17216.254.40:8444/ccosws administrator e 20
sync Directio Auto Transfer Employee Group
XM WEB ~— Nodap - No - Seleot valuc

Figure 27: IXM WEB - Enable Nedap AEOS Link Module
STEP 3

Enter the Nedap AEOS WEB Service URL. For example: https://172.16.254.40:8444/aeosws

STEP 4

Enter Web Service Username and Web Service Password for accessing the web service.

STEP 5

Specify in seconds how often sync should take place.
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STEP 6

Select Sync Direction.

Select one-way sync direction IXM WEB < Nedap to import a person from Nedap AEOS to IXM
WEB.

Sync Direction

IXM WEB — Nedap

Figure 28: IXM WEB - Sync Direction

STEP 7
Auto Transfer

No: Employees synchronized from Nedap AEOS will not be automatically added to any of the
employee groups present in IXM WEB.

Auto Transfer

No

Figure 29: IXM WEB - Auto Transfer No

Yes: On selecting ‘Yes’ for Auto Transfer, an employee group selection dropdown enables
which displays all the employee groups present in IXM WEB. All the employees synchronized
from Nedap AEOS will be automatically added to the employee group selected on Link
Configuration Page.
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Auto Transfer Employee Group

Yes ‘ All Employees

Figure 30: IXM WEB - Auto Transfer Yes

STEP 8
Click Apply

After applying your changes, you should see items being updated on the screen below:

ACTIVITIES

Numbers ‘ Numbers ‘ Times

Added Added to IXM WEB Last run at 17 May, 2022 4:03 PM

Updated Updated in IXM WEB Next run at 17 May, 2022 4:04 PM

Deleted Deleted in IXM WEB 0

Figure 31: IXM WEB - Sync Activities
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STEP 11

Clicking Sync Now immediately starts synchronizing pending data. This is useful when you do
not want to wait until the next scheduled run shown by “Next Run At”.

STEP 12

If sync direction is selected as Nedap AEOS to IXM WEB (One-way sync) then the Sync All
button will get displayed.

STEP 13

The Sync All feature allows a re-sync of the database from Nedap AEOS to IXM WEB. This will
re-import missing cardholders or updated cardholders from Nedap AEOS to IXM WEB. Also, it
will delete IXM WEB employee records according to cardholders available in GCC.

RESULT

When data is synchronizing at the given interval, the numbers in view will change accordingly.

46 P/N XAD-TPI-004-03G



INVIXIUM

10. Create System User(s) for Biometric Enrollment

Procedure
STEP 1

Log into IXM WEB.

On the home page, expand the Left Navigation Pane - System. The application will redirect
to the System Users window.

Figure 32: IXM WEB - Create API User
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STEP 2

Click Add New.

Nedap Yes Yes No epandyo@invixiumcom

Figure 33: IXM WEB - Add New System User

Creating a system user requires the following details:

e Login Type
i. Local employee
ii. Domain employee
e Invixium ID (User ID) (For domain employee logins, User ID is automatically filled
from AD)
e Password (For domain employee logins, password creation is not required)
¢ Confirm Password
o Email Address
e Status
e Permission for Modules
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STEP 3

Select Login Type (Local or Domain Employee) from the dropdown list.

STEP 4

Enter Invixium ID and Password for API user.

STEP 5

Add an email address.

Apply for permission as “All” for Employee & Employee Group module.

# System Users

Dashboard

I Employee & Employee Group None

Device & Device Group None
IXM Time None

Login Type General Settings None

Local Employee Notification Settings None

INVIXIUM ID e
Tools None

Enroll
Company Schedules None

Password B L "
Organization Heirarchy None

Logs None

medium
' Licensing

Confirm Password

None

Link None

Reports —
Email P None

L] System &

Status DM Hoalth None

® Cancel

Figure 34: IXM WEB - New System User
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STEP 6

Click Save.

@ System Users

Sytem User saved

Figure 35: IXM WEB - Save System User
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11. Add and Configure Invixium Readers

Adding an Invixium Reader in the IXM WEB application
Procedure

STEP 1

From Home, click the Devices tab.

¥ IXM WEB

Dashboard Employees

Figure 36: IXM WEB - Devices Tab
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STEP 2

Select the Add Device button on the right-hand side of the page. Then select the Ethernet
Discovery option and add the reader’s IP in the start IP section. Click on Search to find the

device.

M IXM WEB

Add New Device

Lst ©n @  Discover wwmwins 2 ROGISEEr  wseeen 3 SUmmary

l i =
N PR § Add
B &  oscovervormons vhod,
/l\ T ®
i vin Ince
N VR @
Broadcast
Tl 192 .88 . 2 | 15 9734 Sedrch on SsL
l Ma
[
SELEGT DEVIGE TO REGISTER [DISCOVERED DEVIGES :1] c
Roboot
35870041
1521682145 TOBIDEATO0AF Firmare
Upgrade
Fectary
Dofauits

Figure 37: IXM WEB - Search Device using IP Address
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STEP 3

Once the device is found, click on it. Enter following details:

e Device Name: Define the name of the device in IXM WEB.
e Device Group: Create a ‘Default’ device group and select it.
e Device Mode: Select device mode as ‘Entry’, ‘Exit’, or ‘Both’ (Based on requirement).

[Z] Add New Device

° DISCOVEr  weere @  REGISIEr  eeeves

‘GENERAL INFORMATION
Name Device ID Device Group Device Mode

TS TITAN FPUS - EKIT o 1item(s) selected * Both v

NETWORK INFORMATION
IP Address Subnet Mask Gateway

DHCP 1921882145 2552562550 19216821

Figure 38: IXM WEB - Register Device
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STEP 4

Click Register.

STEP 5

Once the device has successfully been registered, click Done.

Add New Device

° Discover ® Summary

° Device Registered

Device Information

Device Name Model Name Serial Number Firmware Version
TS TITAN FPUS - EKIT TITAN FPUS b3d587d04f 02.004.097.000

Transaction capacity User Capacity (iN) User Capacity (17)
1000,000 100,000 500,000

Network Information

Comm Mode IPMode IP Address Subnet Mask
Ethernet DHCP 1921682145 255.255.255.0

Gateway MAC ID DNS
192168.21 70:83:05:87:D0:4F 8888

© AddNew v Done

P/N XAD-TPI-004-03G



INVIXIUM

Go to Dashboard and confirm that the Device Status chart indicates that the reader is online
(i.e., hovering will tell you how many devices are online).

~ IXM WEB

Envolimant Status Envoliment Quality Crodentials

Figure 40: IXM WEB - Dashboard, Device Status
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12. Adding an Invixium Device to a Device Group

Procedure
STEP 1

Go to Devices - Groups.

Add the device from the Right Side pane to the respective Device Group.

Dashboard Employees

1st Floor
@

Figure 41: IXM WEB - Assign Device Group
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Assign Wiegand to Invixium Readers

@ Note: Face and Finger will always give a Wiegand output based on the initial card that was
synced from Nedap AEOS to Invixium.

The Standard 26 Bit Wiegand will be used to define which output format will be sent to Nedap
AEOS.

STEP 1
From Home > click the Devices tab. Select any device.

STEP 2
Navigate to the Access Control tab.

¥ IXM WEB

Dashboord L Employees

58
' fcdb405133

Figure 42: IXM WEB - Navigate to Access Control Tab
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STEP 3

Scroll down,click on Wiegand Output and toggle the switch on the top right side to enable

Wiegand Output for the device.

By Wiegand Output

EVENTS

Actual Card
Standard 26 bit
Standard 26 bit

IXM 82 bit Device S/N

None
None
None
None
PULSE (MSEC)
) N
40 . 2000

Nong

Nong

None

Device Serial Number

Device ID

60

Figure 43: IXM WEB - Wiegand Output

The ID types for Wiegand output are as follows:

1. Employee ID
2. Default Card
3. Actual Card

By default, Employee ID is selected in Wiegand Event.

As the Employee ID field is not available in Nedap AEOS, select either Default Card or Actual

Card.

58
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Actual Card: when more than one card is assigned to a cardholder and you want to generate
Wiegand output data for the same card which is presented on the invixium device.

Default Card: It will generate Wiegand output data for the card which is marked as default in
IXM WEB.

Note: For fingerprint and face access, default card Wiegand output data will be generated.

STEP 4
Set the items:

Wiegand Actual Card
Identification 26 - bit
Verification 26 - bit
STEP 5
Click Apply.
@ Wiegand

Output Wiegand saved

Figure 44: IXM WEB - Save Output Wiegand
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RESULT

The Wiegand Output settings of the selected device are now updated.

Note:

= |If you have more devices, follow the next steps to copy all Wiegand settings to all devices
simultaneously. Note: This copies all Wiegand output settings. See Appendix for more
information.

= |f a cardholder was assigned multiple cards, the first assigned card will be the ‘default’

selected card. The details of the card will be sent as the Wiegand bits input to Nedap
Panel.
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Configuring Panel Feedback with Nedap

Procedure

STEP 1

Connect Wiegand Data DO of the Nedap Panel with WDATA_OUTO of the IXM device, Wiegand
Data D1 of the Nedap Panel with WDATA_OUT1 and Wiegand Ground of the Nedap Panel with
WGND of the IXM Device.

STEP 2

Connect the Green of the Nedap Panel with ACP_LED1 of the IXM device.

STEP 3

On the Devices tab, select the required device and navigate to the Access Control tab. Scroll
down and click on Panel Feedback.

Figure 45: IXM WEB - Panel Feedback
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STEP 4
By default, Panel Feedback is turned OFF. Toggle the Panel Feedback switch on the top right

side to the ON position, and then enable LED Control by the panel and set the LED Mode to
One LED.

(5 Panel Feedback

LED Mode Timeout (msec)

LED Control By Panel ‘ One LED ‘ 3000

LED Driving Mode Pulse Processing Time (msec)

[ Enable Pulse Processing ‘ Low ‘ ‘ 500

Status Event on Time (msec) off Time (msec)
] Authentication Success 100
Authentication Fail 200
Retrieve PIN 300
Door Open 400
Door Close 500
Restart Device 800

Release Alarm 700

B APPLY

Figure 46: IXM WEB - Configuring Panel Feedback in IXM WEB

STEP 5

Click Apply.

. Panol Foedback

Panel Feedback configuration saved

Figure 47: IXM WEB - Save Panel Feedback
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Pre-configuration for enroliment

Procedure

STEP 1

Host IXM WEB on https. A certification will be required to configure IXM WEB on https. For
example: https://172.16.254.40:9108

STEP 2

Go to the location where AEOS is installed ->Open Key Store Explorer for importing IXM
WEB’s SSL certificate.

Default Location: C:\AEOS\AEserver\standalone\certs

STEP 3

Go to Tools >Click on ‘Import Trusted Certificate’.

server.jks - KeyStore Explorer 5.4.4

,

File Edit View Tools Beamine Help

] = & | * i Generate Key Pair Ctrl+G = Q | @
server.jks i Generate Secret Key Ctrl+Alt+G
ﬁ Impaort Trusted Certificate Ctrl+T
18| Bre | rt Key Pai Crl+K A
mpol air rl+
ﬂ - e 178 P ey RS
‘ - @ gt KeyStore Password Ctrl+P RS
F = " | @ Change KeyStore Type >
W oa e [ ge hey yp RS
@ KeyStore Properties Alt+Enter
55¢  Preferences Ctrl+Comma

Figure 48: AEOS- Import Trusted Certificate
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STEP 4

Select the SSL certificate and import it.

STEP 5

Go to the location where AEOS is installed > Open the aeos.properties file to make changes
related to enrollment.

Default Location: C:\AEOS\AEserver\standalone\configuration\aeos.properties

STEP 6

Add the below details in aeos.properties file:

bioapi.settings.server.omsl.name=IXMEnroll

bioapi.settings.server.omsl.uri=https:// 172.16.254.40:9108/Link/
bioapi.settings.server.omsl.optional.carrierName=true
bioapi.settings.server.omsl.optional.cards=true
bioapi.settings.server.oms1.optional.PIN=true
bioapi.settings.server.oms1.Content-Security-Policy=default-src 'self’
172.16.254.40:9108/Enroliment/Enrollment/ https://
172.16.254.40:9108/Link/EnrolINedapAEOSUser/ ‘unsafe-inline' 'unsafe-eval'; script-src
'self' https:// 172.16.254.40:9108/Enrollment/Enroliment/ https://
172.16.254.40:9108/Link/EnrolINedapAEOSUser/ ‘'unsafe-inline' ‘'unsafe-eval’; object-src
'self' https:// 172.16.254.40:9108/Enrollment/Enroliment/ https://
172.16.254.40:9108/Link/EnrolINedapAEOSUser/ 'unsafe-inline' 'unsafe-eval'; img-src
'self' https:// 172.16.254.40:9108/Enroliment/Enroliment/ data:
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STEP 7

Open the AEOS application > From the AEOS menu bar, go to Administration -

Maintenance > ldentifiers.

dedS

Filters

Maintenance

Devices
Events & alarms

Departments

Work locations

Labels

Free fields

Messages

(De)activate maintenance mode
Block reasons

Entrance unlock reasons
Identifiers

Favourites

Notification
Settings

Archiva

Figure 49

Administration ]

AEOS

: AEOS - |dentifiers
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STEP 8

Click on Identifier Types = from the Identifier Types dropdown, select the type of identifier
you want to create.

Entrance unlock reasons

Identifiers

Identifier types

Set maximum identifiers
Favourites
Notification

Settings

Archive
Badges
Import carrier
Reports

Faces
Personal [ Print... } [ To file... } [ Delete selection |
AEOS 2021.1 This product is licensed to Invixium - Nedap 1=

Figure 50: AEOS - Identifier Type Selection
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Click on New.

(De)activate maintenance mode
Block reasons
Entrance unlock reasons
Identifiers
Set maximum identifiers
Favourites
Notification
Settings
Archive

Badges [ Print... ] [ To file... ] [ R ]

Import carrier

This product is licensed to Invixium - Nedap

AEOS 2021.1

Figure 51: AEOS - Add New Identifier Type
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STEP 9

Enter the following details for creating an Identifier:

Name: Define an ldentifier with the same name as mentioned for ‘bms1.name’ in the

‘aeos.properties’ file.

For example: IXMEnroll.

Also, enter other mandatory details and Click on OK.

Generic
Name* |[IXMEnroll Identification Type [Alpha numeric
SUBEYpe Identifier length* [6 |
Customer Identifier minimum
\lpha numeric [1 |
code type* value=
| Customer Identifier maximum
[ — [95595 |
code length value*
code conversion
AEOS 2021.1 This product is licensed to Invixium - Nedap

Encode Card
Use external
label

Print receipt
Add leading
zeroes
Leading
character

Printable 1o
Print format
Thirdparty
a label
O] .
-
== ox )]
|
—e=cde= o

Figure 52: AEOS - New ldentifier Type
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STEP 10

From the AEOS menu bar, go to Administration = Maintenance > Settings.

Management

Filters

Maintenance

Devices

Events & alarms
Departments
Work locations
Labels

Free fields

Messages

(De)activate maintenance mode

Block reasons

Entrance unlock reasons
Identifiers

Favourites

Notification

Settings

Archive

| Administration |

AEOS

Figure 53: AEOS- Settings

Authorisati
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STEP 11

Click on System Properties.

ae@s Management Administration

Menu AEOS
Filters
Maintenance
Devices
Events & alarms
Departments
Waork locations
Labels
Free fields

Messages

(De)activate maintenance mode

Block reasons

Entrance unlock reasons
Identifiers

Favourites

Notification

Settings
| System properties

Maintain thumbnails
Auto block

Archive

Figure 54: AEOS - System Properties
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STEP 12

Update the below settings for performing enroliment from Nedap:

e 04.01 - General Default Identifier Type: Select the identifier type created for
enrollment. For example: ‘IXMEnroll’.

Administration

System properties

Maintain system properties

Visible rows: 229

Number a Name ‘ Value

S R

03.04 Default template for cars |:[Z|
03.10 Disable profile editors (excluding standard authorizations, 0SS-S0, LoXS). (]

04.01 General Default identifiertype [IXMEnroll [ +]
04.02 Default identifiertype for employees »
04.03 Default identifiertype for visitors |:E|
04.04 Default identifiertype for contractors I:E

Figure 55: AEOS - System Properties Default Identifier
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e 12.36 - Default BioAPI verification method (overrides default verification
method): Select the identifier type created for enroliment. For example:
‘IXMEnroll’.

Administration

System properties

Maintain system properties

Visible rows: 229

Number a Name ‘ Value

12.14 Default number of days for contractor verification validity ‘

12.17 Holiday schedule overrules verification disabled schedule O

12.36 Default BioAPI verification method (overrides default verification method) | IXMEnroll | = | |
13.01 Export events, using eventfilter: v
13.02 Export events, using entrance filter: [E

13.03 Export events, using AEpu filter: [E

Figure 56: AEOS - System Properties Default BioAPI Verification

e 44.36 - Enable biometric API: Select the checkbox to enable biometric API.

44.33 Enrollment Kosmos weight O
44.34 Enrollment Sagem fingerprint O
| 44.36 Enable biometric APT
44.37 4 eyes verification O

| print... | | Tofile... |

Figure 57: AEOS - System Properties Enable Biometric API
Click on OK.

72 P/N XAD-TPI-004-03G



INVIXIUM

44.32 Enrollment Hitachi fingervein ]
44.33 Enrollment Kosmos weight O
44.34 Enrollment Sagem fingerprint O
44.36 Enable biometric API
44.37 4 eyes verification O

[ Print... ] [ To file... ] [ Cancel ] [ OK |
AEOS 2021.1 This product is licensed to Invixium - Nedap = e

Figure 58: AEOS - Save System Properties
STEP 13

Once all the configurations are saved, restart AEOS services.
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RESULT

The ‘Enroll Biometric Identifiers’ button will be displayed on the Employee/Visitors window.

administrator
Person Administrator Q ® @
Employee
Last name* [Doe Date from* |29/9/2021 12+ X
First name |John Date until I:l‘:
Middle name Creation date 29/9/2021 16:57
Title Modification date 11/1/2022 12:44
Gender Unknowr‘ v ‘ Last time seen  22/10/2021 16:42
Telephone no. Last used entrance IXM Entrance
Mobile no. Last time denied
E-mail Last denied entrance
Language |English ‘ = ‘ Can be user [
Person(nel) no.
Department E
Contact o
Contact person E Telephone no.
I Authorization =
Template |IXMTemplate |*| @ Access during holidays [
Identification =
Identifier type Identifier X 72¢
Enroll Biometric Identifiers;
Expand all Collapse all Hsave expand status
[ = .
AEOS 2021.1 This product is licensed to Invixium - Nedap —e=rd=aEs

Figure 59: AEOS - Enroll Button
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13. Enrollment from Nedap AEOS

The Nedap AEOS application and IXM WEB should be browsed using https on the same
browser session to overcome issues of a self-signed certificate.

Procedure
STEP 1

Open the AEOS application - Select employee/visitor and click on the ‘Enroll Biometric
Identifiers’ button = Perform enrollment from this view.

B B

o
8o
LY

ITEX P B O®mE D@

AEOS 2021.1

IXM WEB

Employees

+2 Add Templates -John Doe (6)
Select Device

» Fingerprints —~( ) - NEAPH
Finger Veins

Face (~1] -

@ Quick \ / \ /

Advanced N e

Click here to

JVEN

13 Employees

This product is licensed to Invixium - Nedap

Figure 60: AEOS - Biometric Enroliment

T

Follow Invixium Enrollment guidelines for proper enrollment of faces, fingerprints, and finger

veins.
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14. Enrollment Best Practices

Fingerprint Enrollment Best Practices

Invixium recommends using the index, middle, and ring fingers for enroliment.

Make sure your finger is flat and centered on the sensor scanning area.

The finger should not be at an angle and should be straight when placed on the sensor.

Ensure that the finger is not too dry or too wet. Moisten your finger during enroliment if

needed.

Avoid Poor Fingerprint Conditions

Wet Finger: Wipe excessive moisture from the finger before placement.

Dry Finger: Use moisturizer or blow warm breath over the finger before placement.

Stained Finger: Wipe stains off from finger before placement.

Enrollment Best Practices

|_:| IZ| Pressure
L& )
! g .
Position
hi
- ( ‘ Rotation

" Condition

Preferred Fingers

Figure 61: Fingerprint Enroliment Best Practices
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x Incorrect

Too Low

L]
]

Too High

;V: Correct

]
&
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Fingerprint Image Samples

Fingerprint Sample Result Recommendation

Always try and get a
good fingerprint like
this for a good
enrollment score

Good Fingerprint

Invixium recommends
) ) ) using

Fingerprint with cuts _ _
Card + Biometrics or

Card + PIN

Moisten finger and re-

Dry finger enroll for better results

Rub finger on clean
Wet/Sweaty finger cotton cloth and re-
enroll for better results

Figure 62: Fingerprint Images Samples
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Fingerprint Imaging Do's and Don'ts

Do's:
= Capture the index finger first for the best quality image. If it becomes necessary to capture
alternate fingers, use the middle or ring fingers next. Avoid pinkies and thumbs because
they generally do not provide a high-quality image.
= Ensure that the finger is flat and centered on the fingerprint scanner area.
= Re-enroll a light fingerprint. If the finger is too dry, moistening the finger will improve the
image.

= Re-enroll a finger that has rolled left or right and provided a partial finger capture.

Remember to:
= |dentify your fingerprint pattern.
= Locate the core.
= Position the core in the center of the fingerprint scanner.

= Capture an acceptable gquality image.

Don'ts:
= Don't accept a bad image that can be improved. This is especially critical during the
enrollment process.

= Don't assume your fingerprint is placed correctly.
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Finger Vein Enrollment Best Practices
= |nvixium recommends using the index and middle fingers for enrollment.
= Make sure your fingertip is resting on the finger guide at the back of the sensor cavity.
= The finger should be completely straight for the best finger vein scan.

= Ensure that the finger is not turned or rotated in any direction.

Preferred Fingers x Incormect %Cﬂrrect
! L7
y 2 J o ¥ —
Ba L R " el
| O 7
‘ g
[ =
L
H

Figure 63: Finger Vein Enroliment Best Practices
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Face Enrollment Best Practices
Invixium recommends standing at 2 to 3 feet from the device when enrolling a face.

Make sure your entire face is within the frame corners, which will turn green upon correct

positioning.
Look straight at the camera when enrolling your face. Avoid looking in other directions or

turning your head during enrollment.

5
x Incorrect i‘,{ Correct

<2 feet ;‘ > 3 feet 2‘ 2-3 feet

120 cms /

48 inches
120 cms /
48 inches

120 cms /
48 inches

Figure 64: Face Enrollment Best Practices
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15. Prerequisites for Getting Access in AEOS

The following configurations are required in Nedap AEOS for user access.

Procedure

STEP 1
Open AEmon and select the AEpu that is connected to the Invixium device.

%5 AEmon connected to 1 AEpu
File View AEpu System Configuration Comyp

s ¢ |

Figure 65: AEmon — Aepu
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STEP 2

Go to View > Select Configuration.

& AEmon connected to 1 AEpu

Configuration

Log
Hardware
Events
Program log
AEpus

Reset Views

Graphical mode F7

Component properties F&
Event filter »

Figure 66: AEmon - AEpu Configuration
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STEP 3

On the Configuration window search for StandardDoor - Add StandardDoor.

smponent Group Graphical Test Log Help
Configuration X |Hil'dwae

© Zoom In Zoom Out Zoom To Fit Zoom Normal | Redrs

|-

standarddoar

Figure 67: AEmon - Add Standard Door
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STEP 4
Right Click on StandardDoor - Select Rename component.

Save component...
Report component
Copy component

Maedify cormponent...
Delete component

Create event filter...

Select related

State monitor

Properties...
]

Figure 68: AEmon - Rename Component
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Define the name of standard door = Click on OK.

% Rename Component

Name 'StandardDoor. InvixiumDevice|

[ Ok || cancel

Figure 69: AEmon - Rename Standard Door

STEP 4

To deploy changes on the panel, right-click anywhere on the ‘Configuration’ window - click
on Deploy Configuration.

New configuration

Open configuration

Close configuration

Save configuration...

Save configuration as template...
Report configuration

New component...

Open component...
Find compenent...

Paste component

Apply group..

Figure 70: AEmon - Deploy Configuration
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STEP 5

Open the AEOS application - From the AEOS menu bar, go to Configuration -
Maintenance > Confirm Access Points.

Management Administration Authorisation Entrance Configuration

AEOS

Maintenance

Entrances

View configuration
Access points

Maintain AEpus

Lookup servers
License

Zones

Figure 71: AEOS - Confirm Access Points

STEP 6

All the created Access Points will be displayed on this page - Select Access Point and click
on the Add button.

S s 2 2 2 - 2 administrator
Administration Authorisation Entrance Configuration Monitor Administrator ‘n‘ ® {

Confirm access points

Confirm tically di points

Visible rows: 1 F’ @ @
[] Access point ‘ Host name Type

I StandardDocr.InvixiumDevice I aepu StandardDoor

——

AEOS 2021.1 This product is licensed to Invixium - Nedap Hre=cde=e

Figure 72: AEOS - Add Access Point
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Once the Access Point is confirmed it will be displayed on the Access Points window—-> To

verify, go to Configuration - Maintenance >Access Points.

deds

administrator
Administrator

Maintenance

Confirm access points
Entrances

View configuration
Maintain AEpus
Lookup servers

Access points

Maintain access point

Access

————— !

[ Save query as... ] [ Reset ]

Visible rows: 1

[ 0=

Max. rows |100

f

License || Access point 4 | Status Type Door status |
Zones ¥ [ StandardDoorInvixiumDevice resent StandardDoor aepu Unknown
Responses
Media
Figure 73: AEOS - Access Point
STEP 7

To add a new entrance, go to Configuration - Maintenance > Entrances.

deds

]

Configuration

Maintenance

Confirm access points

Entrances

View configuration
Access points

Figure 74: AEOS — Entrances

Click on the New button.
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Maintenance Maintain entrance
Confirm access points
Entrance name Function |E| Country
Entrances B
) Location Site
View configuration Description Sub site

Access peints

Maintain AEpus

Lookup servers

License visible rows: 0 REREB
Zones [J Name a | Location Description Automatic lo... ‘ Automatic u... | Toggle sche... | Ver
Responses
Media No results found.
My Tasks [ Print... ] [ To file... ] [ Delete selection ] [ Import... New
My Queries

AEOS 2021.1 This product is licensed to Invixium - Nedap o p—p—

Showall = X

9 syncPage working..zip  ~

Figure 75: AEOS - New Entrance

STEP 8
Define Entrance Name = Click on Add Access Points button.

Maintain entrance

Name* [Invixjum Devices Entrance | Country
Tocauon | | Site
Description | | sub site

Functicn |~

| Add access points |

Visible rows: 0

Figure 76: AEOS - Create New Entrance

Select the Access Point that you want to add for this Entrance and click on the OK button.
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Entrances

Search access point

Entrance name Invixium Devices Entrance

S —

Type |

caee I . raw 1000

RDR

Visible rows: 1

[J Access point a ‘ Type | Host name Description
| StandardDoor.Invixium... StandardDoor | aepu
[ Print... ] [ To file... ] [ Delete selection ] [ Cancel } [ OK
AEOS 2021.1 This product is licensed to Invixium - Nedap == e

Figure 77: AEOS - Add Access Point in Entrance

Once the Access Point is added click on the OK button.

Maintain entrance

nMame* [[nvixium Devices Entrance | Country
Location Site
Description | Sub site

Function ||~
Add access points

Visible rows: 1

FRE

Host name |

Name a | Type
*  StandardDoor.Invixium.. StandardDoor aepu I
[ Cancel ] [ OK ]l
AEOS 2021.1 This product is licensed to Invixium - Nedap Hre=cde=me

Figure 78: AEOS - Save Entrance

STEP 9
Go to Authorization - Maintenance >Day/time Schedules to create a new schedule.
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| Authorisation I

Maintenance
Templates
Entrance groups

Day/time schedules

Holidays
Ooverview

Figure 79: AEOS — DayTimeSchedules

Select Weekly Schedule from the dropdown and click on the New button.

Day/time schedules

Maintain day/time schedules

Name [ | Type | [-]
[ Save query as... ] { Reset ] Nothing found. Max. rows { Search J
Visible rows: 0 D D D
[ Name a Description ‘ Type | No. of d... | 1

No results found.

New }

[ Print... ] [ To file... } [ Delete selection ]

wthorisation# 21.1 This product is licensed to T ! Weekly schedule ==

Figure 80: AEOS - New Weekly Schedule
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STEP 10

Define Schedule Name - Define the start and end time for the new schedule as per your
requirement > Click on the OK button.

Day/time schedules

Maintain day/time schedule

| Name* [weekly Schedule | | Cop
Description | |
Time 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23
Monday
Visible rows: 0 D D D

[] starttime a | End time |

No results found.

From Hour Minute Add
until  Hour [13]+] Minute

Delete selection [ Cancel ] [ OK ]

AEOS 2021.1 This product is licensed to Invixium - Nedap ]

Figure 81: AEOS - Define Weekly Schedule

STEP 11

For Employee Groups creation, go to Authorization - Maintenance »>Employee Group.

I Authorisation I

Maintenance
Templates

I Entrance groups I

Day/time schedules
Holidays

overview

Figure 82: AEOS - Entrance Groups

Click on the New button.
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Entrance groups
Entrance groups

Name || ] Region [[~] Area [|=] Entrance [ |

| Organization [[*]

Description |
Save query as... ] [ Reset ] Nothing found. Max. rows 1000
Visible rows: 0 D D D
[ Name a ‘ Description Region }
No results found.
[ Print... ] [ To file... ] [ Delete selection [ Copy ] [ New
AEOS 2021.1 This product is licensed to Invixium - Nedap Hrae=rdemap

Figure 83: AEOS - New Entrance Group

STEP 12
Define Entrance Group Name - Click on Add Entrances button.

Entrance groups

Maintain entrance group

Name* [Invixium Entrance Group J F*aginn [I=]

Description | |
| Add entrances |

Oorg

Visible rows: 0

Figure 84: AEOS - Add Entrance in Entrance Group

Select the Entrance which you want to add to this Entrance Group and click on the OK button.
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Entrance groups

Search Entrance

Entrance name | Function [[»] Country |||
Location | site ||~
Description | Subsite | |

[ Save guery as... } { Reset } Max. rows 5000 | {

Visible rows: 2
[] Name a | Location | Description

Invixium Devices Entra...

T TA/RA M

(unc.. | [Tone.. ] (cance |

AEOS 2021.1 This product is licensed to Invixium - Nedap

Figure 85: AEOS - Add Entrance Group

Once the Entrance is added click on the OK button.

Entrance groups

Maintain entrance group

Name* |Invixium Entrance Group

Description
Add entrances

Visible rows: 1

] Name & | Location

I x Invixium Devices Entra... I

Delete selection

AEOS 2021.1 This product is li

Figure 86: AEOS - Save Entrance Group
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STEP 13
For Template creation, go to Authorization - Maintenance »>Templates.

[ Authorisation }

Templates
Maintenance Maintain templates
Templates
Name ||

Entrance groups

Day/time schedules
[ Save guery as... ] [ Reset ] Mothing foun

Holidays

Overview Visible rows: 0

[] Name a
Personal

Mo reculie foumd

Figure 87: AEOS — Template

Click on the New button.

Templates

Maintain templates

Mame Description
p

[ Save query as... ] [ Reset ] Mothing found.

Visible rows: O D D D

[ Name a Description

No results found.

[ Princ... | [ Tome... | [ petete selection | [ conce [l New |

AEOS 2021.1 This product is licensed to Invixium - Nedap laml— 11— 11—

Figure 88: AEOS - New Template

STEP 14
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Define Template Name - Click on the Add button for adding an Entrance Group to the
Template.

Templates
Maintain templates

| Name* [Authorization Template

Destriptor—t

Entrance groups

[J Name a

Figure 89: AEOS Template - Add Entrance Group

Select the Entrance Group from the list of Entrance Groups and click on the OK button.

Templates
Entrance groups

Neme [ | regon [[] area [[5] Entrance [a] i
N — Organization [[5]

[y, ) (e . o

Visible rows: 1 E’ @ %
[J Name a ‘ Description | Organization |
| Invixium Entrance Group |

Figure 90: AEOS Template - Add Entrance Group
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Select Schedule from the dropdown for the selected Entrance Group and click on the OK
button.

Templates

Maintain templates

Name* |Authorization Template
Description

Entrance group name iaci Group
Schedule |[Weekly Schedule |

[ cancel | | I

Figure 91: AEOS Template - Assign Schedule to Entrance Group

STEP 15
Click on the Add button for adding an Entrance to the Template.

Templates

Maintain templates

Name* [Authorization Template
Description |

crange ) (oel

Figure 92: AEOS Template - Add Entrance
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Select the Entrance from the list of Entrances and click on the OK button.

Templates

Search Entrance

Entrance name Function |E| Country

Location Site

Description Sub site
[sove queryas... [Lresst) ax. rows [5000]]
Visible rows: 2 D D D
] Name & | Location Description Automatic lo... ‘ Automatic u... | Toggle sche... | Verificati

| Invixium Devices Entra... |

(o o]

Figure 93: AEOS Template - Save Entrance

Select the Schedule from the dropdown for the selected Entrance and click on the OK button.

Templates

Maintain templates

Name* [Authorization Template ]
Description | |

Entrance name _Invixium Devices Entrance
Schedule |[weekly Schedule I~

Cancel OK

Figure 94: AEOS Template - Assign Schedule to Entrance
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STEP 16

Once Entrances and Entrance Groups are added to the Template, click on the OK button.

Name* [Authorization Template |

pescription [ ]

Entrance groups

[ Name a | Description Schedule
UJ Invixium Entrance Group Weekly Schedule

Entrance

[ Name a | schedute

| 77 Invixium Devices Entrance weekly schedule |

Figure 95: AEOS - Save Template

P/N XAD-TPI-004-03G



INVIXIUM

STEP 17

Assign the created Template to a new/existing person from the Authorization tab in order to
grant access to the person.

Employee
Last name* |Doe | Date from* ]
First name |John Date until l:l""
Middle name Creation date
Title | Madification date
Gender Unknown‘ - ‘ Last time seen

Telephone no.

Last used entrance

Mobile no. Last time denied
E-mail Last denied entrance
Language |English ‘ = ‘ Can be user [

Person(nel) no.
Department | | ~ |

Contact

Contact person E Telephone no.
IAuthorization I =

]3 Access during holidays [

Identification =

Identifier

Template

Autherization Template

Identifier type

Hexpand all B collapse all  Esave expand status

frnt

Figure 96: AEOS - Assign Template to Person

RESULT

All the Employees/Visitors with Authorization Templates will only get access in Nedap
AEOS.
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16. OSDP Configuration

The following configurations are required in IXM WEB and Nedap AEOS to use the OSDP
feature.

Note:

1. The Nedap panel needs OSDP-supported firmware to use OSDP communication with
the Invixium device. It can be found at the default location of AEOS i.e.,
C:\AEOS\AEmon\firmware

2. Wiegand Out should be in the Invixium device (Refer Assign Wiegand to Invixium
Readers).

3. Standard Door should be created, and all the prerequisites should be configured to get
access in the Nedap AEOS (Refer to Prerequisites for getting Access in AEQS).

Procedure

STEP 1
From Home, click the Devices tab. Select the required Device and navigate to Access Control
- Click on OSDP.

By default, the OSDP configuration is turned OFF. Enable the OSDP by toggling the switch to
ON.

Display OSDP Text Smartcard Passthru Enable Biometric

3083132333435363738393A3B3C3D3E3F000000000000000000000000000000000000000000000000000000000000000000C | HEX

EVENTS ONCOLOR OFF COLOR ON TIME (MSEC) OFF TIME (MSEC) DISPLAY MESSAGE

Figure 97: IXM WEB - OSDP Settings
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STEP 2

Supply values for the configuration settings below:

The baud rate of the serial communication. The value must

Baud Rate be the same as the Access Control Panel’s value.
Parity Bit The parity bit of the serial communication. The value
anty bl must be the same as the Access ControlPanel’s value.
_ The stop bit of the serial communication. The value must be
Stop Bit

the same as the Access Control Panel’s value.

This logs OSDP events for support and debugging
Enable Log purposes. Invixium recommends disabling this feature
unless needed.

When presenting a smart card, the device passes the
Smartcard Passthru smart card CSN (Card Serial Number) to the Access
Control Panel without taking any other action.

Enable Biometric Enables biometric template verification.

The secure key is provided by your Access Control Panel
Secure Channel most of the time. However, provisions for manual entry can
be added as TEXT or HEX.

The OSDP static events for panel feedback and capture pin
are:

Access Granted
Access Denied
Enter Pin

Dual Authentication — It is an access mode that requires
valid access by two authorized cardholders to enter an
access zone within a specified time period. This feature is
available only if the Multi-User Authentication feature is
enabled and configured. To configure the Multi-User
Authentication feature, from Home, click the Devices tab.
Select the required Device and navigate to General
Settings. Click on the Multi-User Authentication
section. Upon enabling this feature, the following actions

Event
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will be performed:

« The Device will request the credentials of the second
user after the first user is authenticated successfully.

« Card numbers for both, the first and the second user
will be transferred to the Access Control Panel.

Two events, one for the first user and the other for the
second user will be logged into the Access Control Panel.

The LED color configuration based on panel events. The
value must be the same as the Access Control Panel's
value. Options are:

On Color/Off Color + Red
« Green
+ Yellow

+ Blue

Table 5: IXM WEB - OSDP Configuration Options

Note: Mismatches between the unit and Access Control Panel LED configuration will cause
unrecognized events.

Display OSDP Text Enables to display OSDP Text.

Notification on the device’s screen.

If enabled: Displays both the unit hard-coded
notification and the Access Control Panel notification.

Display Message IXM notification - Access Granted or Access Denied.
Access Control Panel notification — Valid or Invalid.
If disable: Displays only the Access Control Panel
notification.

Table 6: IXM WEB - OSDP Text Options
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STEP 3

Click Apply to save the settings.

@ osoP

OSDP settings saved

Figure 98: IXM WEB - Save OSDP Setting

STEP 4

Open the edit option on the reader and note the Device ID. This will be the address used in the
configuration of the reader in Nedap AEOS.

Device ID: 0

/ d ' \ TS TITAN FPUS - EKIT ® Online & Edit |

Transactions Authentication types Device Category Comm Mode
850 Face Recognition, Fingerprint Lenel OnGuard Ethernet

Overview Employees Communication Notification Security AccessControl  General Settings  Time & Attendance S )

Figure 99: IXM WEB - Edit Device
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#' Edit Device
INFORMATION
TS TITAN FPUS - EKIT
NETWORK

ETHERNET

192 . 168 2 . 145

SERIAL

Select

WI-FI

o .| o o . o0

Select

.| 255 |

1item(s) selected v

255 0

192 188 .
RS-232
0 0

Ethernet

Both

9734

T&A Device

@ Note: Invixium’s reader address should be the same as the OSDP reader address.

STEP 5

Wiegand input and output also need to be configured to allow OSDP communication to work.

Create the same settings for Wiegand connections as you did previously.

STEP 6

Disable Panel feedback for any OSDP-connected reader to stop multiple access granted
messages from being sent to Nedap AEOS.
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STEP 7

Once OSDP settings are applied to the Invixium device, the device will be added to ‘AEmon’ as
new hardware.

=) Panel Feedback

LED Mode Timeout (msec)

[] LED Control By Panel Two LED ' 3000

Figure 103: IXM WEB - Disable Panel Feedback

O] Configuration Il-liu'dmxll
|

TDevices

-2 Bus-0SDP-Device(100) f88367 be313731 v-28.31.0

Figure 101: AEmon - OSDP Device
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STEP 8

Click on Configuration - Define behavior of the OSDP device as shown in the image below.

'BUS-OS
(102)
Bus-0S uni D) [] Green1
AP.(,:)DB (102) dooro unli D} :j)FlOsd:
Read1 dood oty ut AP7803
0SDP AL Read2 ] B oa B 1] Amber1 (1)
N1 g IN1g il dda D] ] Bluet D Relay A
IN2gf IN2C lock dotl D o
IN3 IN3Q unlock lo poue
0SDP B+ IN4 [ norm bu > 2ak
INaCH Tamp O} inh badge D) D Relay B
INSQY PFailg) snoa pinal > B Outd
IN6 ) Pin1 O abUn! bblpin b Outs
EIM;GMPC Pin2 O ver outdal ] £ Oous
:C"S&E dotlp >4 B BusCfg
Batt low (]
Vraw O
Viock O
n— STr—

Figure 102:AEmon - OSDP Device Behavior
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STEP 9

Right click on Standard Door > Properties.

Save component...
Report component
Copy component

Rename component...
Madify component...
Delete component

Create event filter...

Select related

State monitor

Properties...

Figure 103: AEmon - Standard Door Property
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STEP 10

Click on the ellipsis button of Primary Identifier Type.

% Properties StandardDoor. TITANT (AccessPoint:StandardDoor)

MName Value

Figure 104: AEmon - Primary Identifier Type
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Configure identifier type as shown in the image below and click on OK.

% Identifier Type

et e

Input Settings AEServer Settings
swipe o vt
[ Dats type fiter | Identifier length 2]
— R —
st [y ] @M O
¥ O OR et o v
Etpns'linnEI
- o
Length Ebﬂs
TR

Customer code
[[] Fixed code Customer code length EI

o
Eit position D
Length Dby‘m

Target Identifier

-

[ Reverse bytes

Figure 105: AEmon - Configure Primary ldentifier Type
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STEP 11

Configured Identifier Type will be displayed as Primary Identifier Type - click on OK.

% Properties StandardDoor. TITANT (AccessPoint:5tandardDoor)

Figure 106: AEmon - Generic Primary Identifier Type
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STEP 12

To deploy changes on the panel, right click anywhere on the ‘Configuration’ window - click on

Deploy Configuration.

New component...

Mew configuration

Open configuration

Close configuration

Save configuration...

Save configuration as template...
Report configuration

Open component...
Find component...

Paste component

Apply group...

Figure 107: AEmon - Deploy Configuration
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17. DIP Configuration

The following configurations are required in IXM WEB and Nedap AEOS to use the DIP feature.

Note:
1.

Readers).

2. Standard Door should be created, and all the prerequisites should be configured to get
access in Nedap AEOS (Refer to Prerequisites for getting Access in AEOS).

Procedure

STEP 1

Wiegand Out should be in the Invixium device (Refer Assign Wiegand to Invixium

Open AEmon, select the AEpu that is connected to the Invixium device - go to the
Configuration tab.

Zoom In Zoom Out Zoom To Fit Zoom Marmal Redraw | Show Groups | [] State Monitor Selective

Type to Filker

AccessPoint
Display
Integrator
Intrusion
Logical
MessageMapper
Miscellaneous
Monitoring
Protection
Service
Devices

~ 1
L
W
-]

P> badge unl
[> dooro urili
> doorl roai
P maul noa
> emul doa
P> lock dotl
P unlock o
= norm bu
> inh badge
= snoa pinal
> ablinl bhipin
P wer outda
> aif dotlp
P> fhim

[> e auth

B> tarmper

Figure 108: AEmon - Configuration tab
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STEP 2

Search for ACLabelConverter > Add ACLabelConverter.

Configuration xll—ladwae

Zoom In Zoom Out Zoom To Fit Zoom Normal

=

aclabelconverter

=~ | AccessPoint
I L. 4 ACLabelConverter

Figure 109: AEmon - Add ACLabelConverter
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STEP 3

Connect ‘Output Data1’ of StandardDoor with ‘Access Point Status’ of ACLabelConverter.

Linl [
Lnli =
noai
noa [=
dda [
ot [

la [

b [
hadoe [
pinal =
hhlpin
outdal [=
datlp [

Figure 110: AEmon - StandardDoor and ACLabelConverter Connection
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STEP 4

Right click on GenericDevicelnterface - click on Properties.

Save component...
Report component
Copy component

Rename component...
Maodify component...
Delete component

Create event filter...

Select related

State monitor

Properties...
LAt

datlp [

Figure 111: AEmon - GenericDevicelnterface Properties
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STEP 5

Click on the ellipsis button of Device Channel Address.

% Properties TestUtility (Integrator:GenericDevicelnterface)

Mame

Figure 112: AEmon - Device Channel Address
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STEP 6

Click on the Add button - Define 8 digits of the Channel address - click on the OK button.

% Device channel address info

[ #ad ]| remove | [F0RT] [T0own]

Channel address Enabled

Figure 116: AEmon - Add Channel Address
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STEP 7

Deploy changes on the panel. To deploy, right click anywhere on the ‘Configuration’ window
- click on Deploy Configuration.

New configuration

Open configuration

Close configuration

Save configuration...

Save configuration as template...
Report configuration

New component...

Open component...
Find component...

Paste component

Apply group...

Figure 113: AEmon - Deploy Configuration
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STEP 8

Open IXM WEB, from the Left Navigation Pane go to Link - click on the AEOS (Nedap) icon
- click on the Add DIP Settings button.

Link
Nedap

=]
Status iy

‘ Numbers | | Numbers ‘ ‘ Times

Updated Updated in IXM WEB

Added Added to IXM WEB Last run at 13 Jan, 2022 4:03 PM
Next run at 13 Jan, 2022 4:03 PM

Deleted Deleted in IXM WEB

DIP Settings

No record(s) found

+ Add DIP settings

Figure 114: IXM WEB - Add DIP Settings
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STEP 9
Enter the below details:

e Status: Select ‘Status’ to enable DIP settings on the device.

e Debug: This logs DIP events for support and debugging purposes. Invixium
recommends disabling this feature unless needed.

e Device: Select the Invixium device on which you want to enable DIP settings.

e Port: Enter the communication port number which is used for communication between the
Invixium device and the Nedap panel. Default value: 8001

e |P: Enter the IP address of the panel.

e Channel Address: Enter the Channel address specified in AEmon (Refer Add Channel
Address in AEMon).

e Timeout: Provide a timeout value (in seconds) for getting a response from the Nedap
panel. Default value: 10 seconds.

Click on the Save button.

DIP
Status Debug
: ;);.I\:’I-TITAN - 8001 -
192 168 17 42 IXMDIP
= IXMDIP_V2
12345678 10 -

o Delete

Figure 115: IXM WEB - Save DIP Settings

120 P/N XAD-TPI-004-03G



INVIXIUM

STEP 10

Once DIP settings are applied on the Invixium device, the device will be added in ‘AEmon’ as
new hardware.

"p._'“ AEmon connected to 1 AEpu
File View AEpu System Log Help

AEpus X | i=] Configuration I Hardware X | I
£y acru

"

T Devices

B Trran-Fyz(son

APTO03rs435MR 2Wieg128Max_1778 v 1,12

Figure 116: AEmon - DIP Device
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STEP 11

Go to the Configuration taband define the behavior device and panel as shown in the below
image.

StandardDoor
StandardDoor | nvixium Device
= badge unl B
= dooro unli B
= doorl noai [>
= rmaul noa [
P emul dola [
P lock caotl B
= unlock lo [

> norm b [
i badons )

= snoa pinal [
= akblnl bhblpin B
= ver outda’l B
> aif dotlp [
= fhm

= e auth

P> tamper

Figure 117: AEmon - DIP Device Behavior
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STEP 12
Right click on Standard Door > Properties.

Save component...
Report component
Copy component

Rename component...
Madify component...
Delete component

Create event filter...

Select related

State monitor

Properties...

Figure 118: AEmon - Standard Door Property
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STEP 13
Click on the ellipsis button of Primary Identifier Type.

% Properties StandardDoor TITANT (AccessPeint:StandardDoor)

MName Value

Figure 119: AEmon DIP - Primary Identifier Type
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Configure identifier type as shown in the below image and click on OK.

% |dentifier Type

AEServer Settings

Identifier type

[Joata type fiter | Identifier length

Badge number Identifier minimum value |1
oot @ramrc Ores

Bit position b e El
o o

Identifier maximum value |55535

Length

Customer code

[] Fixed code Customer code length [0 |
o

Bitpositon [0 |

length [0 |bytes

Target Identifier

e o

[]Reverse bytes

Figure 120: AEmon DIP - Primary Identifier Configuration
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STEP 14
Configured Identifier Type will be displayed as Primary Identifier Type - click on OK.

% Properties StandardDoor TITANT (AccessPoint:StandardDocr)

Figure 121: AEmon DIP - Generic Primary Identifier Type
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STEP 15

In order to deploy changes on the panel, right click anywhere on the ‘Configuration’ window >
click on Deploy Configuration.

New cenfiguration

Open configuration

Close configuration

Save cenfiguration...

Save cenfiguration as template...
Report configuration

MNew component...

Open compenent...
Find component...

Paste component

Apply group...

Figure 122: AEmon - Deploy Configuration
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18. Wiegand Configuration

The following configurations are required in IXM WEB and Nedap AEOS to use the Wiegand
feature.

@ Note:

1. Nedap panel’s firmware must be compatible with Wiegand to use the Wiegand feature
with the Invixium device. It can be found at the default location of AEOS i.e.,
C\AEOS\AEmon\firmware

2. Wiegand Out should be in the Invixium device (Refer Assign Wiegand to Invixium
Readers).

3. Standard Door should be created, and all the prerequisites should be configured to get

access in Nedap AEOS (Refer to Prerequisites for getting Access in AEOS).

Procedure

STEP 1

Connect Wiegand Data DO of the Nedap Panel with WDATA OUTO of the IXM device, Wiegand
Data D1 of the Nedap Panel with WDATA_OUT1 and Wiegand Ground of the Nedap Panel with
WGND of the IXM Device.
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STEP 2

Open AEmon, select the AEpu that is connected to the Invixium device - go to the
Configuration tab ->Define the behavior of the device as shown in the image below.

Standardidoor
StandardDoor. | mvixiumDeyice
> badge unl [ ]
= doora unli B=r—
= door noai B :E
= m awl noa b= | ;
= e mul doa [> U
= lock ot [
= unlock 1o [
= narm b [
= inh badge [
= =nos pinal =
= aklinl Bk lpin [
= wer outdal [
= aif dotlp [
[ flam
=& auth
Etamper

Figure 123: AEmon - Wiegand Device Behavior
STEP 3

Right Click on Standard Door - Properties.

Sawve component...
Report component
Copy component

Rename component...

P odify component...

Delete component

Create event filter...

Select related

State monitor

! Properties...

Figure 124: AEmon - Standard Door Property
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STEP 4

Click on the ellipsis button of Primary Identifier Type.

% Properties StandardDoor. TITANT (AccessPoint:StandardDoor)

MName

Figure 125: AEmon Wiegand — Primary Identifier Type
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Configure identifier type as shown in the image below and click on OK.

” Identifier Type

et

AEServer Settings

Identifier type

Identifier length

Identifier minimum value |1

Identifier maximum value  |65535

Sub type E

Customer code length D

Bit position [0 |
Length D bytes

Target Identifier

roe

[] reverse bytes

Figure 126: AEmon Wiegand - Configure Primary Identifier Type
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STEP 5
Configured Identifier Type will be displayed as Primary Identifier Type - click on OK.

% Properties StandardDoor. TITAN1 (AccessPoint:5tandardDoor)

Figure 127: AEmon Wiegand- Generic Primary ldentifier Type
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STEP 6

In order to deploy changes on the panel, right click anywhere on the ‘Configuration’ window >
click on Deploy Configuration.

Mew configuration

Open configuration

Close configuration

Save configuration...

Save configuration as template...
Report configuration

MNew component...

Open component...
Find component...

Paste component

Apply greup...

Figure 128: AEmon Wiegand- Deploy Configuration
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Appendix
Pushing Configuration to Multiple Invixium Readers

Procedure

STEP 1

To push these configurations to other Invixium readers, while the configured Invixium device is
selected, click the Broadcast option on the right-hand side.

Figure 129: IXM WEB - Broadcast Option

STEP 2

Scroll down to the Access Control section and check the Wiegand Output option.

Figure 130: IXM WEB - Wiegand Output Selection in Broadcast
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STEP 3

Click Broadcast.

®) Broadcast

] select All

[] Access Control
D Anti-Passback |:| Door Access Control

[] Fire Alarm O Input/Output

Wiegand Output

["] schedules

[[] Access schedules [] siometric Schedule

[] security

[] Anti-shock vandal Protect... [ pevice

[] smart card

D Active HF Protocol D Active RF Protocol

@ Sselect

D Door Open Schedule

D OSDP

[[] Holiday schedules

[ P Restriction

[] CsN order Type

2  Device(s)

[ poor strike Power Supply [] external server Feedback

[] Panel Feedback [] Wiegand Input

[ Telnet

D HID Mobile Access D Key Management

Figure 131: IXM WEB - Broadcast Wiegand Output Settings
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STEP 4

Select the rest of the devices in the popup. Click OK to copy all Wiegand output settings of the
source device to all destination devices.

Note:

@) Broadcast

SELECT DEVICE(S) Type to search

« B4l Device Group

M - P

Merge FP4 132 Wout

Search

Figure 132: IXM WEB - Broadcast to Devices

Popup will display devices of the same category only.
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Wiring and Termination
Procedure
Earth Ground

For protection against ESD, Invixium recommends the use of a ground connection between
each Invixium device to a high-quality Earth Ground on site.

STEP 1
Connect the green and yellow earth wire from the wired back cover.

STEP 2

Connect the open end of earth ground wire provided in the install kit box to the building earth
ground.

STEP 3

Screw the lug end of the earth ground.

Earth Ground |
Wire Lug

Earth Ground

Wire Lug

Earthing Wire from —
Wired Cover (PIN 5) Bullding Earthing

Figure 133: Earth Ground Wiring
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WIRING

Top Connector
1.3 5 7 9 1113 15 17 19 21 23 25 27 29

2 4 6 8 1012 14 16 18 20 22 24 26 28 30

Bottom Connector
1 3 5 7 9 1113 1517 19 21 23 25 27 29

2 4 6 8 1012 14 16 18 20 22 24 26 28 30

Figure 134: IXM TITAN — Top & Bottom Connector Wiring
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Get Wired Top Connector
Wire Color - Wire

Get Wired Bottom Connector
Wire Color Wire

Figure 135: Power, Wiegand & OSDP Wires
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All Invixium devices support Wiegand and OSDP.

Invixium devices can be integrated with a Nedap Controller on:

1. Wiegand (one-way communication)
2. Wiegand with panel feedback (two-way communication)
3. OSDP (two-way communication)

Wiegand Connection

WDATA OUTO [
WDATA_OUT1

WGND —

Figure 136: IXM TITAN - Wiegand

@ Please refer to the INGUIDE document provided for each product on Invixium.com under the
Download section of the Products menu.
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Wiegand Connection with Panel Feedback

Access Control Panel Connections

TITAN
I s - ACP
[]
= j WDATA_OUTO A |
‘ WDATA_OUT1
‘ WGND
L‘ 4
I
’ = . ACP_LED1
{ ACP_LED_GND )

Top Connector Wiegand
WDATA_OUTO . (16)

N

WDATA_OUT1 ] (18)

WGND I (20)

Bottom Connector LED . . .

ACP LEDI — ACP_LED signals can be used if available on the Access Control Panel.
ACP_LED_GND === (11) IXM devices support up to 2 wires + GND for LED status.

Figure 137: IXM TITAN - Panel Feedback

Please refer to the INGUIDE document provided for each product on Invixium.com under the
Download section of the Products menu.
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OSDP Connections

OSDP Connections
= | j

Top Connecter RS-485

SGND 6) —
RS-485+ (8) NN
RS-485- (10) I

OSDP wiring requires daisy chain connections between devices and twisted pair.
A termination resistor R (~120 ohms) across RS-485 lines is also recommended.

Figure 138: IXM TITAN - OSDP Connections

Please refer to the INGUIDE document provided for each product on Invixium.com under the
Download section of the Products menu.
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19. Troubleshooting

Reader Offline from IXM WEB Dashboard
Note: Confirm communication of the IXM WEB server to the Invixium reader.

Procedure

STEP 1

From Home, click the Devices tab.

STEP 2

Select any device.

STEP 3
Navigate to the Communication tab.

¥ IXM WEB

&4

Dashboaord Employees

Figure 139: IXM WEB - Device Communication Settings
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STEP 4
Scroll down and click on IXM WEB Server.

(%) oM settings
Ethormet

8 extornal USE Settings

7 XM WEB Server

uR

tpy//17218.254,40:9108

= Serial

49 usB Auxiliory Port

G vow

Figure 140: IXM WEB - Server URL Setting

Ensure the correct |IP address of the server is listed here. If not, correct and apply.

STEP 5
Enter the IP address of the Invixium server followed by port 9108.
Format: http://IP_IXMServer:9108
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STEP 6
Navigate to General Settings and make sure that the URL reflects the same setting.

Gallagher { IXM WEB

NZ New Zealand

Wiegand  Smart Card Settings  IXM WEB Server  LDAP

B

Home

Video Surveillance {§} Configuration

Organization Hierarchy i Cloud Port

http;//17218.254.40:9108 1255

@ &

Logs

Notification Settings

Link

=

License

()

®

Sync

frf

General Settings

Figure 141: IXM WEB - Server URL Setting from General Setting
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Logs in IXM WEB Application
Device Logs: Device Logs are used for debugging device-related issues.

From Home - Click the Devices tab on the top > Select the required Device - Navigate to
the General Settings tab for the device - Click on Device Log - Enable Capture Device Logs.

: Device Log

Capture Device Logs

APPLY & DOWNLOAD [l @ DELETE < RESET

Figure 142: IXM WEB - Enable Device Logs

Click Download to initialize the process to download the device log file.

TSTOUCH2FP2 = oniine # Edit

1691 Fingerprint Enterg Opening Devicelogs.ency X
Communication You have chosen to open: P
Clock " Devicelogs.ency v
which is: ency File (1.5 MB)
% Device Log from: http://192.168.1.60:9108 ~

a4 Capt Devi L
B cCapuure evice Logs What should Firefox do with this file?

@Save File

Display

Do this automatically for files like this from now on v

5 IXM WEB Server Verification
OK Cancel

Multi-User Authentication

:,‘ Sensor Test

Figure 143: Save Device Log File
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Select Save File and Click OK to store the device log file on your machine.

Transaction Logs (TLogs): Events or activities taking place on the IXM device.

¢ Transactions Logs can be viewed and exported from IXM WEB.

e Goto Logs in Left Navigation pane in IXM WEB and click on Transaction Logs. A filter
option is available in the Transaction Logs column.

Application Logs: Application logs are available for any event, error, or information generated
in IXM WEB.

e Application Logs can be viewed and exported from IXM WEB.

e Goto Logs in the Left Navigation pane in IXM WEB and click on Application Logs. A filter
option is available in the Application Log column.

Logs folder location on IXM WEB Server:

IXM WEB Logs C:\Program Files (x86)\Invixium\IXM WEB\Log
IXM WEB Service C:\Program Files (x86)\Invixium\IXMWebService
Logs

IXM API Logs C:\Program Files (x86)\Invixium\IXMAPI\Log

Table 7: Logs Folder Location
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20. Support

For more information relating to this document, please contact support@invixium.com.

21. Disclaimer and Restrictions

This document and the information described throughout are provided in their present condition
and are delivered without written, expressed, or implied commitments by Invixium. and are
subject to change without notice. The information and technical data herein are strictly
prohibited for the intention of reverse engineering and shall not be disclosed to parties for
procurement or manufacturing.

This document may contain unintentional typos or inaccuracies.

TRADEMARKS

The trademarks specified throughout the document are registered trademarks of Invixium. All
third-party trademarks referenced herein are recognized to be trademarks of their respective
holders or manufacturers.

Copyright © 2023 Invixium. All rights reserved.
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